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Product Overview  
 

OptiInstrument software graphical user interface (GUI) is designed to communicate and control 

with different instruments and devices through SCPI commands. OptiInstrument software allows 

users to connect multiple devices over physical layer or TCP/IP protocol layer.  

 

OptiInstrument enables the automation of testing and characterization of modules and devices 

using its powerful command sequence builder where a user can build a sequence of commands 

involving various instruments from different vendors to perform the testing.  

 

OptiInstrument software has a Python script generator which allows users to create an executable 

Python script for the command sequence which can be used for the automation process. The 

Python script can be executed independently of OptiInstrument GUI.  

 

OptiInstrument also has a data acquisition feature which allows the user to import graphical 

waveform data from a device as well as command sequence output results and then export the 

data in an appropriate format.   
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GUI Description 
The GUI of Instrument is shown below. The following is a description of its icons, fields and 

toolbar. 

 

Menu Bar 
The menu bar of OptiInstrument GUI is shown below. It has a standard File, Edit, View and Help 

dropdown menus for various functions. 

 

File 
File menu has all relevant functions to enable users to save, open and create new files of 

sequence commands.  
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Edit 
Edit menu contains functions such as Undo, Copy, Paste and Cut of SCPI commands which are 

typed in the command testing and command sequence windows described below. 

 

 
 

View 
View menu contains functions such as show/hide different windows as well as sequence 

execution Status Bar and instrument Caption Bar. The user can also customize these drop-down 

menus using Customize… option under the View menu. 

 

 

Status Bar and Caption Bar 
The user can enable/disable the Status Bar and the Caption Bar by selecting or unselecting the 

relevant bar from the View drop-down menu.  

 

The Status Bar appears at the bottom of OptiInstrument GUI as shown in the image below. It 

contains a progress bar on the left side, which shows the execution progress of the sequence of 

commands.  

 
The Caption Bar appears at the top of OptiInstrument GUI, just below the menu bar as shown in 

image below. The Caption Bar initially is blank with no text in it. However, when the user 
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attempts to connect to any instrument, the bar displays “Searching for available instruments” as 

you can see in the image below.  

 
Once OptiInstrument software has detected and connected to an instrument(s), it changes the 

text showing current active instrument’s name. When a new instrument is connected, the text 

displayed in the bar is “Working on it”.  

 

Help 
The Help drop-down menu contains information on the software build version as well as contact 

and support details as shown below. 
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GUI Toolbar 

 
The Toolbar shown in the image above appears just below the Menu bar and it has several 

buttons for various application in the GUI. 

The  button is used for connecting the software to the available device(s)/instrument(s), 

which are either physically connected or though TCP/IP RAW socket connection. Once the button 

is pressed, OptiInstrument is automatically connected to all of available device(s)/instrument(s) as 

it will show up in the Instruments tab. 

The  button is used for waveform data acquisition. This button allows the user to acquire 

graphical data after the sequence of commands of an instrument has been executed. Once this 

button is pressed, the GUI acquires the waveform data and store it in an excel csv spreadsheet as 

shown in the Display window. It also acquires the waveform displayed when the user switches 

the setting from Grid tab to Graphs tab.  

The  button allows the user to hide/show the command sequence window.  

The  button allows the user to hide/show the display window used to display the acquired 

data of a waveform in a grid format and in a view mode format.  

The  button opens the About OptiInstrument window, which shows the product build 

version and Optiwave’s contact information as well the technical support details.  

Navigation Panes 

There are different navigation panes in OptiInstrument GUI. The title of the different available 

panes is shown in the image below. Users can switch between the panes by simply clicking on the 

relevant tab shown in the image. When a tab is selected the color of its background changes from 

grey to light blue. The functions of each pane are described below. 
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Instruments 
The Instruments pane has the connection control and connection setting parameters. Users 

establish communication between OptiInstrument software and the instrument(s) using this 

pane. The pane shows all connected instrument(s) to the GUI in a list format when the expand 

sign (+) on left of the instrument name is clicked as shown in the image below. Less information is 

displayed when the minimize sign (-) is pressed. The instrument alias setup as well as the display 

option of either the resource name or alias name is also available in this pane. 

 

 

List of Command Sequence 
 

This pane lists the sequence of SCPI commands that a user has built previously and had loaded to 

OptiInstrument GUI or he is currently building as shown in the image below. This pane allows the 

user to export, import and save the sequence of commands in an XML format. It also allows the 

user to edit the commands as well as the sequence, modify and delete command(s) from the 

sequence.  
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There are different buttons on the top left of the List of Command Sequence pane, which allow 

the user to perform different functionality such as import, export, and add or close the command 

sequence. The description of each button is the following: 

•  button allows the user to open a sequence command saved in an XML file.  

•  button allows the user to open and add to an existing sequence or to a sequence the user 

is currently working on. 

•  button allows the user to save a sequence of commands as an XML file. 

•  button allows the user to clear the existing list of sequences from the pane. 

 

 

 

SCPI Commands 
This pane lists; as a default, the common SCPI commands defined per IEEE488.2 standard and 

make them available in the list of commands for the user. This list has the main commands that 

are supported by most instruments and devices that support SCPI commands.  

The SCPI Commands pane allows the user to open XML files that has the SCPI command for 

various instruments that user may be working with. The list is shown under the common 

commands. Using the maximize (+) and the minimize (-) controls on the left of the command file 

name, users can expand the list into a more detailed list of commands. Users can keep clicking on 

the (+) sign on the left of each command in the list to expand it into more detailed (long) form of 
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the SCPI command until the full command details are displayed as shown in the image below. 

Similarly, by clicking the (-) sign the list collapses.  

There are several buttons on the top left of the SCPI Commands pane, which allow the user to 

import, export, add to existing list and delete command(s) from the pane.  

The  button allows the user to import an XML file containing specific SCPI commands of the 

instrument. 

The  button allows the user to open commands list. 

The  button allows the user to delete command(s) from the opened list of commands, except 

the common commands list which by default are always open in the tab.  

The  button allows the user to collapse the expanded command list into a collapsed list for 

better visualization of open commands.  
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Documents 
This pane allows the user to open any type of documents. Once the document is imported, the 

title of the document will be shown in the pane as illustrated in the image below.  

There is a single button on the top left side of the pane. This button  allows the user to import 

any kind of documents to OptiInstrument GUI. To open the document, simply double click on it. 

The document opens only if the type of file is supported on the machine hosting OptiInstrument 

software. For example, if the document is a pdf file, then it will open using Adobe Reader or any 

other pdf compatible application.  
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Python Script 
This pane is used for Python scripting. When a user executes any command through the command 

execution window, OptiInstrument creates an executable Python script for that command. The 

generated script can be executed using command prompt. This pane allows the user to save, 

modify and execute any Python script as well. This capability allows users to execute features that 

are not supported by OptiInstrument GUI such as logic control and looping options.  

There are various buttons located at the top of the Python Script pane as shown below. Some of 

them are similar to those of the toolbar. 

 

The  button allows you to open Python script files in OptiInstrument GUI, which can be 

executed from the GUI. The Python script can also be modified and saved as well. 

The  button is used for saving the Python script files. 

The next three buttons  are for cut, copy and paste, respectively, which are standard 

for the text editing. 

The  buttons are used for undo and redo functions.  

The  button is used for placing dots in white spaces in the script, so the script text is more 

legible and easier to modify.  

The  button is used for text font settings. When the user clicks on the button, a dialog box with 

various font attributes opens up as shown in the image below. Users can change font type, size, 

and colour of the text. Also, users can change the foreground and background colors so the text 

is easily visible and can be differentiated between different segments in the script.   
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The  button is used for executing Python scripts. An example of a Python script generated for 

a sequence of SCPI commands is shown below. This script can be executed using  button.  
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Connecting GUI to Instruments 
 

Users need to follow the steps below to connect Instrument(s) either remotely or physically to 

OptiInstrument software computer host.  

Manual Connection: TCP/IP Supported Instruments 
1. Make sure that the instrument you are trying to connect to is connected via an ethernet cable 

or wirelessly to the same network that OptiInstrument software host computer is connected to 

it via TCP/IP protocol. 

 

2. Type the instrument/device’s IP Address and the port number in the specified fields for the 

TCP/IP compatible instrument as shown below. 

 

3. Press  button to connect to the instrument. 

 

 
 

4. It will take few seconds for the instrument/device to connect and show up in the Instruments 

tab. 

Automatic Connection: Serial, GPIB, USB and TCP/IP Supported 

Instruments 
1. For physically connected instruments, the user does not need to specify the IP address and 

Port number of the instrument to allow automatic connection.  

2. Press the refresh button to connect Serial, USB and GPIB bus interface instruments to 

OptiInstrument software as shown below. There are two refresh buttons, one located above 

the menu bar and the other one is located in the Instrument’s panel. Pressing this button will 

automatically connect the instruments to the GUI and show them up in the Instruments tab.  

3. The refresh button can also be used to connect to available instruments automatically, which 

are connected to the same network as the workstation. In this case, it does not matter what 

type of connection, physical or over TCP/IP, it detects them and connects to them.   
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Setting-up Instrument Alias 
Once the instrument is connected to the OptiInstrument GUI, the user can assign an alias name 

for it. The alias name can be easily recognized and identified for the instrument. 

1. Press the alias button  shown in the Instruments pane to open the alias setup dialog box. 

 

 
 

2. The alias setup dialog box shows all available connected instruments as well as previously 

saved instruments in the registry. There are three columns in the dialog box, which are the 

instrument’s Resource name, Alias name and Description of it as shown below.  

3. To assign an alias name for any instrument, highlight the column of Alias name, then click the 

raw beside the instrument of interest to assign an alias name for it. 
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4. Select the current Alias name and modify it as needed.   

 

 
 

5. To save the alias name, check the box in the In Registry column beside the updated alias name. 

It is not required to update the alias name in the future when connecting to the same 

instrument.  

 

 
 

6. Press OK to save the changes made as shown below.  



20 
 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



21 
 

Executing a Single Command in OptiInstrument 
A single SCPI command can be written and checked in a specific window in OptiInstrument GUI, 

which allows users to send the individual command to a specific instrument. The command 

testing window is shown below.  

 

 

Command Test Window  
All connected instruments are added to the drop-down menu at the top of the testing window as 

shown below. This feature allows the user to select the instrument intended for testing a specific 

command.   

 

 
 

The drop-down list of the connected instruments is shown in the image below. The user will select 

the desired instrument for testing a specific command.  

 

 
 

There are few buttons present in the top bar of the test window pane. The plus button is used for 

adding the command that is tested to the sequence of commands the user is building in the 

command sequence window. The plus button is shown in the image below.  
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The clear button shown below is used for clearing any SCPI command typed in the text box of the 

command testing window.  

 

The id button is used for sending an identification query to a selected instrument as shown below.  

 

The Python script generator button is used for creating a script for the individual SCPI commands 

tested. The Python script can be executed in the command prompt or Windows PowerShell. 

 

Instrument TCP/IP Setting 
There are various parameters that user can set in OptiInstrument software for the instrument 

connection protocol. The settings can be accessed using the two tabs at the bottom left of the 

command testing window as shown in the image below. The I/O tab allows the user to send a 

command and receive the response from the instrument, which is displayed in the output box.  

The Settings tab allows the user to modify the connection settings for the instrument such as 

Timeout, Termination Methods, Packets Methods and Buffer Settings and many more.   

 

Depending on the type of connection to the instrument, the Settings tab will look different as it 

will have different fields to reflect the type of connection.  
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Executing a Command 
The single command testing window shown below allows the user to send individual commands 

to an instrument. 

 

To test a single command in the command test window, use the following steps: 

1. Selected from the drop-down menu the instrument intended for testing the command as 

shown below. 

 
 

2. Select the Settings tab shown below to modify any necessary setting like the termination 

character, timeout period, buffer settings, etc.…  
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3. Type a SCPI command in the text field of the command test window. Depending on the type of 

command, click the relevant execution button to get a proper response from the instrument. 

There are three execution buttons, Write, Query and Write\Read as shown below. The Write 

and Query buttons are mostly used for executing commands. However, the Write\Read is 

another way of executing a Query command as well as Write.  

 

 
 

Once the appropriate execution button is pressed, the command is executed. A VI_SUCCESS 

message is displayed in the execution status box beside command type drop-down menu if the 

execution is successful. If the command is not executed properly, an error thrown message by the 

instrument will display in this box depending on the type of error. 

 
 

The response of the instrument to the command is displayed in the output window shown below 

if the command is executed successfully. The successfully executed commands can be used for 

sequence building as discussed in the next section. 
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Command Sequence Window 
The Command Sequence window is used for creating and executing a sequence of commands. 

This window has several functions for creating, editing, executing and saving a sequence of 

commands.  

Toolbar Buttons 
The toolbar of the Command Sequence window is placed at the top of the window as shown 

below. The toolbar has many buttons that are used for various functionality in building the 

sequence of commands.  

 

 

1. Execution buttons 

The  button is used for executing the entire sequence of commands in the window. 

The  button is used for executing partial selected commands in the sequence.  

 

2. Up/down buttons 

The  button is used for moving commands up in the sequence of commands from their current 

position. 

The  button is used for moving commands down in the sequence from their current position. 

 

3. Add/load sequence buttons 

The  button is used for adding a command sequence to an existing list of commands or to load 

totally new sequence of commands.  

The  button is used for loading a sequence of commands from a list of sequences to the 

command sequence window. 

The  button is used for updating a sequence of commands that the user is currently working 

on. 

 

4. Sequence builder buttons 

The  button is used for erasing all existing commands in the command sequence window. 

The  button is used for removing empty lines in the command sequence window.  

The  button is used for removing a single command from the list of commands by selecting the 

row that has the command then click the delete button to remove it from the sequence.  

 

5. Clipboard and action buttons 
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The  button is used for copying commands from the sequence.  

The  button is used for pasting commands to the sequence in the window. 

The  button is used for undoing the last action performed by the user. 

The  button is used for redoing the last action done by the user. 

 

6. Python script generator button 

The  button is used for creating a Python script for the sequence of commands built using the 

command sequence builder in the window. 

 

7. Command sequence naming 

The tab shown below is used for naming the sequence commands in built in the window. before 

the user adds to a list of sequences in the list of command sequence window. The user MUST 

specify the name of the sequence before it can be added to the list or before exporting/saving. 

 

 
 

8. Command delay  

The Sleep time (delay time) between commands [s] shown below is used for setting a specific 

delay between commands when executing the sequence. This time is required for some 

commands in the sequence to allow successful execution. The delay time applies to all 

commands. As a result, the user needs to check if it is necessary to set this time and find the 

proper value of the delay time because it delays the full execution of the sequence.  

 

 

Command Sequence Window Functionality 
The command sequence window can be undocked off OptiInstrument GUI like any other window 

in the GUI. This allows the user to flexibly expand or contract the size of the window as desired. 

To pop-out the window, double-click anywhere in the highlighted area shown below at the top of 

the Command Sequence window. 
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The window can also be placed or docked wherever in the GUI. This can be achieved by 

simultaneously clicking and dragging the top of the window.  

 

 

The window placement assistant appears as shown below allowing the user to place it anywhere 

in the GUI by dragging the window the desired arrow. 
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The image below shows the docking of the command sequence window automatically in the 

selected place. 

 

 
 

Creating a Sequence of Commands 
Make sure that all instruments are all connected to OptiInstrument GUI. Then follow these steps: 

1. Select the desired instrument to control or automate from the drop-down menu in the single 

command execution window. 

 
 

2. Type in the desired SCPI command that the user wishes to execute in the selected instrument. 
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3. Before executing the command, make sure that the TCP/IP settings for the instrument such as 

right termination character, timeout period, and buffer size are appropriate.  

 

 
 

4. The user can either test the command before it is added to the sequence or simply add it to 

the sequence.  The type of command must be manually specified from the drop-down menu 

located beside the command typing box as shown below. The user can add the command to 

the sequence by simply clicking the add button located on the top left of the window as shown 

in the image below. 

 

(NOTE: if the command is added after it has been executed in the window, the right command 

type is automatically reflected in the sequence of command) 
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5. After the command is added to the command sequence window, it will appear in the window 

as shown in the image below.  

 

 
 

6. Repeat the steps 1 to 5 to add the desired commands to the sequence and build the full 

sequence of commands as shown below. 

 

 
 

7. The sequence of commands can be modified by moving commands up or down from their 

current positions, delete any command or commands, removing empty line or lines.  

 

8. To set a sleep time (delay time) between successive commands, enter the desired value of 

seconds in the box located at the top right corner of the window as shown below. 

 

 
 

9. To execute the final sequence of commands, click the Run button in the toolbar shown below.  
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10.  To add a new sequence to the list of the sequence of commands in the window, the user 

MUST first enter the command sequence name, then press Add button as shown below. The 

new sequence will appear and added to the original list of commands. 

 

 
 

11.  The user can export/save the sequence of command into an XML file format. To save the 

sequence, click the export button shown below and save it to the desired folder. 

 

 

 

Sequence of Commands Processing 
The command sequence window has a toolbar at the top, which allows the user to modify existing 

sequence or a new sequence being created. 
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Execute Selected Commands from the Sequence 
To execute a select number of commands, first select the required commands by simultaneously 

pressing CTRL on the keyboard and selecting the commands as shown below. 

 

 
 

Once commands are selected, click the Run Selected button shown below to execute those 

commands only. 

 



33 
 

Moving Commands up/down in a Sequence 
Select the desired command from the sequence and click move up button as shown in the image 

below. 

 
 

To move the desired command down, select it from the sequence and click move down button as 

shown in the image below. 

 
 

Deleting Command(s) and Removing Empty Lines 
To remove a single command from the sequence, select the command and press the Erase 

button.  

 

To remove an empty line from the sequence, click the Remove button located in the toolbar as 

shown in the image below.  
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To delete all the commands in the sequence, click the Erase All button located in the toolbar as 

shown in the image below.  

 

As shown in the image below, all of the commands have been deleted and the command 

sequence window is empty. 

 
 

Saving the Results of Executed Sequence of Commands  
To save the output results after executing the commands sequence, click the Export Results 

button located in the toolbar at the top of the command sequence window as shown the image 

below. The results are saved in a .CSV file format. 
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Display Window 
Display Window Functions 

OptiInstrument GUI allows users to acquire the displayed waveforms in two way: graphical and 

data values saved in a .CSV spreadsheet format.  

Acquire Waveform and Data 
Once the sequence of commands for an instrument that produces waveforms is executed, the 

waveform is displayed in the Display Window in OptiInstrument GUI. The user could acquire the 

displayed waveform of the instrument as an image and acquire the relevant data in a .CSV 

spreadsheet form. First, select the relevant instrument from the Available Instruments drop-

down menu as shown in the image below. 

 
 

Click the Display Waveform button in the GUI toolbar. The instrument produced waveform will 

be displayed in Display Window when selecting the Graphs tab as shown below. The waveform 

data can be displayed in an Excel sheet when the Grid tab is selected.  
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Saving/Exporting Waveform and Data 
There are two buttons located at the top left of the Display Window.   

The  button is used for clearing the displayed waveform and data from the Display Window. 

The  button is used for saving the acquired waveform data in a .CSV file format.  

Waveform Visualization and Manipulation  
When displaying a waveform in the Display Window after selecting the Graph tab, a menu with 

many display and control options for the graph manipulation can be accessed by selecting the  

icon that is placed at the top left of the display as shown in the image below. The list of graph 

manipulation options are shown below. 
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Display Window Functionality 
The display window can be undocked from OptiInstrument GUI and float independently. This 

feature allows the user to flexibly expand or contract the size of window to fit their requirements. 

To pop-out the window, double-click anywhere in the highlighted area at top of the Display 

Window as shown below. 

 

The Display Window will be separated from the GUI and becoming floating window. The user can 

resize the window by grabbing any corner of the window and dragging it to whatever size as 

shown below.  
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The Display Window can also be placed wherever in the GUI, this can be done by simultaneously 

clicking and dragging the top of the window. The window placement assistant icon will appear to 

allow the user placing the window anywhere in the GUI by dragging it to the proper arrow as 

shown below. 

 

 
 

 

  

The image below shows the Display Window is automatically placed where it was dragged to. 
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